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Create Your First Project
e Open Vivado: Launch the Vivado Design Suite.

Step 1: click "Create Project”, to create a new project.

¢ Vivado 2023.1 - X
File  Flow Tools Window Help Q- Quick Access

Vivado

ML Edition

- Recent Projects

Quick Start L
ps_hello

Create Project > Ci/Users/User/Desktop/FPGA/ps_hello

Open Project > Vivadorled

Open Example Project > C:fUsers/User/Desktop/FPGA/course_s1_fpga/01_led/vivado_ led
project_S
CifUsers/User/Desktop/FPG project
project_1

Tasks C/Users/User/D pIFPC project
final

Manage IP > C:/Users/User/Desktop/FPGA/project/final

Open Hardware Manager > new

Vivado Store > Ci/Users/User/Desktop/FPGA/project/new
project_4
C:/Users/User/Desktop/FPGA/project/project_4
project_3

. C:/Users/User/Desktop/F project

Learning Center
project_2
C:/Users/User/Des project v

[TeiConsole |

H R Type here to search i \# Result A & T dx

Step 2: A wizard for creating a new project will pop up, click "Next”

4\ Vivado 20231 - a

File  Flow Tools| P e PRl 2

AM D n AM Da Create a New Vivado Project

A . This wizard will guide you through the creation of a new project
Vivado Vivado

ML Edition ML Edition To create a Vivado project you will need to provide a name and a location for your project files. Next, you will specify the type of flow you'll be working with.
Finally, you will specify your project sources and choose a default part.

Quick

Create Proje|
Open Projec

Open Examg

Tasks

Manage IP
Open Hardw
Vivado Store

Learr

. v
® o

Tcl Console

ENG ™M

H L Type here to search i ] > ﬂ SO ] f Result A T T dx IN  5/6/2024 B
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Step 3: In the pop-up dialog box, enter the project name and the directory where the project to be
stored. Let’s take example of "ps_hello” as a project name. Need to pay attention to the project path
"Project location". And click on Next.

File

AMD(Z

Vivado
ML Edition

Flow  Tool:

Quick

Create Proje|

Tasks

Manage IP 3
Open Hardw
Vivado Store|

Learr

Tcl Console

4 New Project

Project Name
Enter a name for your project and specify a directory where the project data files will be stored.

Project name: |psih|ello

Project location: C:/Users/User/Desktop/FPGA

[ Create project subdirectory

Project will be created at: C:/lUsers/User/Desktop/FPGA/ps_hello

©)

X
[
|
-
D
!

H L Type here to search

@ 28°C Sunny

ENG 1241PM

AR e B

Step 4: Here we need to select the Project Type. Select "RTL Project” as project type. Then click on Next.

File  Flow Tools|

AMDZ1
Vivado

ML Edition

QuicH

Create Proje|

Tasks

Manage IP
Open Hardw
Vivado Store|

Learn

| TeiConsole |

4 New Project

Project Type
Specify the type of project to create.

(?)
2

RTL Project
You will be able to add sources, create block designs in IP Integrator, generate IP, run RTL analysis, synthesis, implementation, design planning and analysis.

[*) Do not specify sources atthis time

("] Projectis an extensible Vitis platform

Post-synthesis Project
You will be able to add sources, view device resources, run design analysis, planning and implementation.

10 Planning Project
Do not specify design sources. You will be able to view partipackage resources.

Imported Project
Create a Vivado project from a Synplify Project File.

Example Project
Create a new Vivado project from a predefined template.

Cancel

H P Type here to search . i B = ? @ 28°C Sunny

ENG 1243PM E
2

A B B dk

IN  5/6/
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Step 5: In this window we need to select Target Language and Simulator language, choose "Verilog" as
Target Language and “Mixed” as Simulator language then click on “Next”

’
File\ Flow . ool * "\ Project 2
AM D n Add Sources
Specify HDL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new source file on disk and add it to your project. You can also add '
Vivado and create sources later.
ML Edition
+
~
Create Proje|
Open Projec]
SECHERIRL Use Add Files, Add Directories or Create File buttons below
Tasks
Manage IP
Open Hardw Add Files ‘ ‘ Add Directories ] ‘ Create File
Vivado Store
Lea rr Targetlanguage: Verilog v Simulator language: = Mixed v
~ n bt
Tcl Console
: - - 1 = = ENG 1247PM
f - 3° ~
ﬂ L Type here to search . @ 33°C Sunny S W s )

Step 6: Click "Next”, do not add any files

e Iom{; New Project X |

AM D a Add Constraints (optional)

N Specily or for physical constraints. [
Vivado
ML Edition

Manage IP
Open Hardw
Vivado Store
Add Files Create File
Learr
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Step 7: In this wizard we need select device Family, Package and speed.
e (Category: All
e  Family: Zyng-7000
e Package: clgd00
e Speed:-2
e Temperature: All Remaining

e Static Power: All Remaining
Then click next.

¢ New Project

Ele  Flow  Tools <
AMD L oermunran
Choose a default Xilinx part or board for your projact v
Vivado
ML Edition
Parts | Board
Reset All Filtars P
(@Il cotcoor [ a ~ Package: | clga00 ~ Temperature: | All Remaining <
Family: | zyna-7000 < Speed: | -2 ~ Static power: | All Remaining <
Create Proje
Open Projec
Search -
Open Examy
Pant VO Pin Count  Avallable I0Bs  LUT Elements  FlipFlops  Block RAMs  Ultra RAMs  DSPs  HNICX  BUFGs  DDRMGS — NOGH
C720075c19400-2 400 100 14400 28800 50 o 66 32 o
[ xe7z0106ig400-2 00 100 17600 8200 o o a0 a2 o
T ks XC720148c1G400-2 400 125 40800 81200 107 o 170 a2 o
aASKS xc72020¢19400-2 400 125 53200 108400 140 o 220 a3z o
Manage 1P
Open Hardw
Vivado Store)
< >
Next Page

N

Step 8: Click "Finish” creating the project

/ - &
Eile  Flow Toolg # MNewProject X

AM D P AM D n New Project Summary

Vivado Vivado @ Anew RTL project named ‘ps_hello’ will be created

ML Edition ML Edition

No source files or directories will be added. Use Add Sources to add them later.
. L No constraints files will be added. Use Add Sources to add them later.
z @ The default part and product family for the new project:
e Default Part xc72010clg400-2
el s Family: Zyng-7000
Open Projec] Package: clg400
Speed Grade: -2
Open Examp]
Tasks
Manage IP
Open Hardw
Vivado Store|
Lea rm To create the project, click Finish
. | v
@ : %
Tcl Console
¢ § 330 = ENG 1253 PM
E L Type here to search @ 32°Csuny A S DA oonns BB
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Step 9: Once the Project is created we need to create Block Design. In order to create Block Design please
expand Project manager, here expand IP Generator then click on Create Block Design as shown in the image
below.

#  Vivado 2023.1 - X
Q-

File Flow Tools  Window Help

AMDAU

Vivado
ML Edition

(2% ~

Recent Projects
’ ps_hzllu-[C:/Users/U‘sEr/DEsktD:/FPGA/pS_hel|D/ps_h¢|ln.xpr]AViVadDZOZ3.1 == X
File Edit Flow Tools Reports Window Layout View Help Q- Qui Ready
=, B >, B oo X * == Default Layout v

Flow Navigator PROJECT MANAGER - ps_hello BN

~ PROJECT MANAGER by §
Sources ?2 00O X Project Summary 200X
£+ Settings
alz|e|+ & Overview | Dashboard
Add Sources _
N ~
sim_1
% 1P Catalog [ > = UtiitySources X Project name: ps_hello
archy | Libtaries. . Compile Ordar Project location Ci/Users/UserDesktop/FPGA/ps_hello
Vv IPINTEGRATOR Product family Zyng-7000
ipeie 2> _ 0O X Project part Xc72010cig400-2
Open Block gn o Top module name: Not defined
Target language: Verilog
SEMGTHIEEDG Simulator language: Mixed
v SIMULATION v
< >
Run Simulation
Tcl Console Messages Log Reports Design Runs x i RO = |
~ RTLANALYSIS = )=
Q|=|= %
» Run Linter
Namea Canctrainte Qtatie WNSR NS WHS THR wRes TPWS Tatal Pawear Failad Rantae Mathadalanv RNA Qrara NAR Qunnactinne T FF
fra f n . ”
.
Step 10: Here no modifications can be done, keep the default "design_1
¢ ps_hello - [C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.xpr] - Vivado 2023.1 - =1 x
Eile Edit Flow Tools Repots Window Layout View Help | O QuickAccess Ready
=, B E > W O X * == Default Layout ~

Flow Navigator BLOCK DESIGN - design_1 ?x

~ PROJECT MANAGER ay
£+ Settings

Sources Design X Signals C e sl Diagram 200X

Qx| -1 2| o + = 2 C = Default View v

Add Sources “

‘o

Language Templates

¥ IP Catalog

~ IPINTEGRATOR

s empty. Press the == button to add IP.
Create Block Design Properties ? -O0OX
Open Block Design o

Generate Block Design = p
Select an obj

tto see properties

v SIMULATION TciConsole x Messages |Log |Reports | Design Runs 2 oo

Q' = 2 Il B B @

Run Simulation

~
~ RTLANALYSIS ps_hello C:/Users/User/Desktop/FPGA/ps_hello -part xc7z010clg400-2
» Run Linter [IE_Flow 19-234] Refreshing IP repositories
[IP_Flow 19-1704] No user IP repositories specified
> Open Elaborated Design (: [IP_Flow 19-2313] Loaded Vivado IP repository 'F:/Xilinx/Vivado/2023.1/data/ip'.
o) create_bd_design "design 1"
<) Wrote : <C:\Users\User\Desktop\FPGA\ps_hello\ps_hello.srcs\sources_l\bd\design_Il\design_l.bd>
v SYNTHESIS el g e e
» Run Synthesis :
> Open Synth v
< >

v IMPLEMENTATION I

ﬂ L Type here to search
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Step 11: Click "Add IP" as shown in the below image.

¢ ps_hello - [C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.xpr] - Vivado 2023.1 - a X
File Edit Flow Tools Reports Window Layout View  Help Q- Quick Ready
=, B E » W & X ¥ == Default Layout v

Flow Navigator (4S8 BLOCK DESIGN - design_1 o 85 S

v PROJECT MANAGER o - !

Sources | Design x Signals 2 B Diagram 200 X
£+ Settings
Q= |H o bR + = #/C = Default View v
Add Sources
Language Templates Add IP (Ctri+))
4 IP Catalog
v IPINTEGRATOR This e 4 buttonto addIP
Create Block Design Properties 2 _00GX
Open Block Design o
Generate Block Design =
Selectan of 0 see properties
V' SIMULATION TclConsole  x Messages Log Reports Design Runs 2. 0N
Run Simulation =
Q £l BE E N
| start_gui ~
v RTLANALYSIS o) create_project ps_hello C:/Users/User/Desktop/FPGA/ps_hello -part xc7z010clg400-2
» RunLinter | INFO: [IP_Flow 19-234] Refreshing IP repositories
| INFO: [IP_Flow 19-1704] No user IP repositories specified
> Open Elaborated Design () INFO: [IP_Flow 19-2313] Loaded Vivado IP repository 'F:/Xilinx/Vivado/2023.1/data/ip'.
7 create_bd_design "design 1"
-] Wrote : <C:\Users\User\Desktop\FPGA\ps_hello\ps_hello.srcs\sources_l\bd\design_l\design_ l.bd>
v SYNTHESIS | update_compile_order -fileset sources_l
» Run Synthesis
> Open Synthesized Design : v
< >
v IMPLEMENTATION v —

Step 12: Here in search icon search for "zynq", double-click "ZYNQ7 Processing System” as shown in the
below image.
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¢ ps_hello - [C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.xpr] - Vivado 2023.1

- X
Eile Edit Flow Tools Reports Window Layout View Help Q- Quick Ready
= b « B ® & p ¥ B T » == Default Layout v
Flow Navigator BLOCK DESIGN - design_1* ? X
v PROJECT MANAGER &y
Sources | Design x Signals o A | Diagram  x Address Editor X 200
£ Settings
Q = M4 # Q@ o X N OQ + & 2, C I | = Defaultview V&
Add Sources
R — design_1 7 Designer Assistance available. Run Block Automation
aizg o > ¥ processing_system7_0 (ZYNQ7 Pro ~
4 IP Catalog processing_system7_0
I
v IPINTEGRATOR | oo il
Search: Q-4 (@ matches) | FIXED_IO + |
Gieate BlockDesign Properties 2 -0OBX% | # Clocking Wizard B) M_AXI_GPO -
Open Block Design & ‘ T ILA (Integrated Logic Analyzer) ‘ FCLK_CLKO
¥ Vicobi | FCLK_RESETO_N o
Generate Block Design P, eieraT ¥ MicroBlaze | 5
R OSee.praperios 4 MicroBlaze Debug Module (MDM) ==
 MicroBlaze MCS |
Vv SIMULATION 5 .
TciConsole  x Messages | Lo Reports | Design Runs o 1R R
San i g <) 3 # SelectiO Interface Wizard |
un Simulation - -
QZ|¢l|BE E| 0  warp initializer |
INFO: [IP_Flow 19-234] Refreshing IP repositories F XADC Wizard ‘ ~
¥ RILANALYSS INFO: [IP_Flow 13-1704] No user IP repositories specified | % 2YNQ7 Processing System |
» Run Linter %) INFO: [IP_Flow 19-2313] Loaded Vivado IP repository 'F:/Xilinx/Vi| |
[ create_bd_design "design 1"
> Open Elaborated Design %) Wrote : <C:\Users\User\Desktop\FPGA\ps_hello\ps_hello.srcs\sourc
update_compile_order -fileset sources_l
startgroup
Vv SYNTHESIS create_bd_cell -type ip -vlnv xilinx.com:ip:processing_system7:s.
» Run Synthesis endgroup
> Open Synthesized Design | G
< | >
T a Tcl cor - ENTER(oselect,ESCtncan:eLCm*OfurlPuztaHsi
Vv IMPLEMENTATION v
Block: processing_system7_0
ENG
L Type here to search Dde
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Step 13: Double click on the Block "processing_system7_0”, to configure related parameters

Diagram x Address Editor 200
@ 6 H x O Q + o & # C o = DefaultView v
F Designer Assistance available. Run Block Automation
M
processing_system7 0
i 0
DOR + |||
- FIXED_IO +|||
o M _AX| GP0 ACLK ZYNO M_AXI_GP0 +
. FCLK_CLKD =
FCLK_RESETD NJ}
- - W
\ : %

Step 14: On the image mentioned below green color are editable.

#° Re-customize IP

ZYNQ7 Processing System (5.5) o
@ Documentation ¥ Presets IP Location #¥ Import XPS Settings
Page Navigator - Zynq Block Design Summary Report
Zynq Block Design
na N | o Peripherats W
PS-PL Configuration £ s Spptcaion Eposer ok (RED)
. 5C o .
Peripheral IO Pins L o oviv e ARM Cortex -AD
- System Lovel cPU
MIO Configuration M: :::
GPIO. } Gic ™| Ace
! (:a‘\lg e ¥ == . | Snoop Control unit | R
Clock Configuration 4 <+ so1 e 1 512 K8 L2 Cache and Controlier I Ports.
USB O | | R
- USB 1 | ocm
DDR Configuration S iw,,ﬂ l SRAM |
ENET 1 Central po ’ L =
SMC Timing Calculation B;’::,‘ FLASH Memory 1
(53:16) Interfaces - | pap |
Interrupts B [ L — ‘ aihetzed <
PP S Programmable DDR2/3,LPDDR2
oy | =S e |||z [ SRR
| ey | Trn
Calculation
DMA $ync ISR
Clock EEEE P ing System(PS)
rocessi 'stem
Resets. I I Generation lrlz1s| o=y
21z o[ ]2]3] DMA | RQ High Petformence;
s, cer | A =t o |0 ERTE oo |
Clock Ports. Master Slave SHA Ports.
Ports Ports
Programmable Logic{PL)
OK I I Cancel
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Step 15: The PS-PL interface uses AXI for data interaction between PS and PL. We'll keep the default
settings for now and configure it in later chapters.

#  Re-customize IP x
ZYNQ7 Processing System (5.5) '

© Documentation  £F Presets IP Location 4F Import XPS Settings

Page Navigator - Summary Report

Zyng Block Design

PS-PL Configuration

PS-PL Configuration Search: -
Mame Select Description
Peripheral /O Pins
>  General
MIO Configuration » AXlMon Secure Enablement o « | Enable AXI Non Secure Transaction

GP Slave AXl Interface
Clock Confi i
oek -onfiguration HP Slave AXI Interface
DDR Configuration

DMA Controller

>
>
> ACP Slave &Xl Interface
>
SMC Timing Calculation 5

P3-PL Cross Trigger interface I: Enables PL cross trigger signals to PS and vice-versa

Interrupts

Step 16: Next, click on 'Peripheral I/0 Pin'. When setting up PS peripherals in ZYNQ, the options can be
overwhelming. Certain pins, like 16-27, can switch between Enet0 or SDO/SD1 functions, but you can only
choose one. Check the schematic or user manual to decide which configuration fits best

#  Re-customize [P b4
ZYNQ7 Processing System (5.5) g

@ Documentation 4F Presets IP Location 4% Import XPS Settings

Page Navigator - Peripheral VO Pins Summary Report

Zyng Block Design

PS-PL Configuration Search: -

Peripheral /O Pins Bank0 | LVCMOS 3.3V~ Bank 1 | LVCMOS 3.3V~
Peripherals 0 1 2 3 4 5 B8 7 & 9 10 11 12 13 14 15 18 17 18 18 20 21 23 233 24 1
MIO Configuration —
» | ] Qad SPIFla e ~
Clock Configuration > [] SRAMINOR F CRAMNGR Flash -
DDR Configuration > LJ NAND Flash MAND Flash
> [] Ethernet 0 Eneto
SMC Timing Calculation .
> [_] Ethernet 1
Interrupts TusBoO
[JusB1
»[JsDo cno
»>[JsDA . —
»[sPo . —_|
> sPid SPI SPI
»[LJUART O 1HARTO 1HARTO 1HARTO HARTA =
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Step 17: The serial port connects to MI048-MI049 on the PS. Enable UART1 (MIO48 MI1049) in the
'Peripheral I/O Pins' options. PS MIO is split into two banks: Bank 0 (BANK500) uses 3.3V LVCMOS,
and Bank 1 (BANK501) uses 1.8V LVCMOS, as shown in the schematic diagram

¢ Reustomie IF
ZYNGT Processing System (5.4) /

© Cocwmantiton © Prosem Plotaten § oot 3PS Semege

Page Mavigarce Perigheral 10 Pk
Zpo) Bt Dl -0 =z 0
PE-PL Canduration Zawet,

Petztenal O Mra |!m-'- M1y «

Perphirid M 17O R 3313 33 34 3 30 3 O3 3 AL 3 MM MM O S G e
W0 Conlpuraten use 1
it
Ciock Conkger ' 600
= Fetwson =0 =T ws
Y
DON Corkgarins L) L. sl
» /”
L ™~ "we ™ Lol -
C Tmng Cacetbon y w1
o W o
> RT 0
Fangh i wra uanre WIS T At Ty i ] ity
7 USAT 1
-t uanr T AT WANTY ARTY _U." AT ARt @
oo
2 "= ol L 263 L *a ] x o
oty ) o o o o Lt ] %ol o
CAN D

Step 18: Next configuration QSPI. select Quad SPI Flash in that click on Single SS 4-bit 10.

ZYNQ7 Processing System (5.5) p
© Documentation %F Presets IP Location ¥ Import XPS Settings
Page Navigator — Peripheral IO Pins Summary Report
Zynq Block Design - O = = ©
PS-PL Configuration Search: | Q-
Peripheral 11O Pins Bank0  LWCMOS 3.3V Bank1 | LWVCMOS 1.8V
Peripherals 0 (123 4 5,8 7 8 8 10 11 12 13 14 15 16 17 18 18 20 21 22 23 24 3
MIO Configuration
~[v] Quad SPI Fla SR Flash =
Clock Configuration ®) Single S5 Single SS 4bit IO
{__) Dual Cu
DDR Configuration o Dual tuag =_b
() Dual Quac Dual Quad SFI (8bit) Dual Quad SFI (8bit)
SMC Timing Calculation
[] Feedback
[
Interrupts SRAMMNOR -
* SRANIOR SRAM/NOR Flash SR
’ MANE Flash cs MNAND Flash
> [_] Ethernet D Eneto
> [ ] Ethernet 1
[JusBO
[JusB1
»[JsDo _ £
< ¥
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Step 19: Configure Ethernet. The terminal is designed with an Ethernet interface, which can be selected
according to the schematic diagram.

ZYNQ7 Processing System (5.5)

® Documentation %F Presets IP Location %F Import XPS Settings
Page Navigator - Peripheral IO Pins Summary Report
Zynqg Block Design o= Q = = [ ]
PS-PL Configuration Search: O
Peripheral /O Pins | Bank1 | LWVCMOS 1.8V

Peripherals 12 14 15 16 17 18 18 20 21 22 33 24 25 26 37 28 29 30 31 32 33 34 35 38 37 38
MIO Configuration

~ [« Quad SPIFla ~

Clock Configuration @) Single 55

DDR Configuration () Dual Quac
() Dual Quac 2
SMC Timing Calculation

[ Feedback

Interrupts

SRAM/MCR Flash, addr0-24]

~ || Ethernet 0 "

[+ MDIO

> || Ethernet1 —
[JusBO e
Juse1

— < >

Step 20: Expand the Ethernet 0 and Select MDIO. After selecting you can MDIO in green color as shown in
the below image.

ZYNQT Processing System (5.5)

@ Documentation %F Presets IP Location 4F Import XPS Settings
Page Navigator — — Peripheral /O Pins Summary Report
Zynqg Block Design - Q ; e o
P3-PL Configuration Search: -

FPeripheral /O Pins

Peripherals 31 32 33 34 35 3G 37 38 39 40 41 42 43 44 45 46 47 48 43 50 51 52 3 EMIO
MIO Configuration

~ [+ Quad SPIFla

Clock Configuration (®) Single 85
DDR Configuration {.) Dual Quac
) Dual Quac
SMC Timing Calculation -
|_| Feedback
Interrupts 5 SRA R E
> AMD Flash

[+ Ethernet 0

EMIO
[¥] MDIO MDIO EMIS
5[] Ethernet 1 Eneti EMIO
Juseo —
[Juse1 115R1
. < >
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Step 21: To Configuration USBO by selecting the USBO as show in the below image.

Step 22: In addition to QSPI, ZYNQ can also boot from an SD card. Choose SD 0 and configure it for

Feripherals 25 28 2y PR 2o 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 45 47 48 49 5O
~ [«] Qiuad SPI Fla ~

(®) single 5=
) Dual Quac
() Dual Quac
[ ] Feedback
’ ANMINOR Flash, addri0-24]
>
~ [+ Ethernet 0
[ MDIO
> ) Ethernet 1 —

[w] usB O s

[(JusB1 o

MI040-MI1045. Use MI047 for card detection to detect SD card insertion. -

v[v| 500

- — EMIO
¥ Card Dete 31 32 33 34 35 38 37 38 39 40 41 42 43 44 45 48 47 48 49 50 51 52 53 EMIO
(] wiite Prot 31 32 33 34 35 38 37 38 39 40 41 42 43 44 45 48 47 48 49 50 51 52 53 EMIO
[ ] Power Car 2 2 - a - 42 a4 e 45 50 52

>80 a1 501 EMIO

» [ sPIo - S0 == EMIO

>8P ' |

Step 23: In GPIO mode on the PS, we can utilize the remaining unallocated MIO pins as general-purpose
I/0. Select MI046 for USB PHY reset in the GPIO MIO configuration. At this point, the peripheral
configuration is completed

viv
lJGPlDMlD 3 32 33 34 35 38 37 38 39 40 41 42 43 44 45 46 47 48 49 AHQ A1 52 53

o

|—| Elhemet P 32 33 34 35 38 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53
W] USB PHY |
- 3 32 33 34 35 38 37 3B 39 40 41 42 43 44 45 48 47 48 49 50 51 52 53
31 32 33 34 35 38 37 38 39 40 41 42 43 44 45 46 47 48 49 R0 5| 52 H3
(] GPIDEMIO Y
. ¢ ¥
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Step 24: Next MIO Configuration.

In MIO Configuration. Ensure that EnetO operates at LVCMOS 1.8V with a fast speed setting and
enable Pullup. These parameters are crucial; failure to adjust them may lead to network connectivity issues.
Keep other settings as default.

Page Nawgano = WO Coofiguramon
2o B0 Desgn Sank DVO VORI LVCMOSIIN Sank 1 VO VORI LVCMOS 18V
PSP Comtpuanon ~

o 'Q X & < ©®

Pangturs VO Pins Search

Percneca o Sonw O Tiee Soees P Owecson  Potm
VO Pergherss =
Ciock Contouraton L eETo =0 16 27
DOR Conriguration » &7 MOWO wos2 . 53
Eneto O 38 _ow L VCIOS 2 8v ~ fast v  enadie v Jow
SUC Tirmng Catcutaton
Enet0 _o L LVCWOS % BV v tast v enatee v Joee
lserepts Enee0 wo 32 nx1] L VCAOS L ey ~ e L
Enet0 MO 5 B =3 L VCMOS 3 8V v  ta ~  enazie v foue
E€netO “o20 Bx% LVCMOS 1 8V ~ 31 v enatie v fow
Ermeo wo21 b ce L VCAROS: 3 8V ~ st v enavke v Joe
Eneco wo 22 ox_cse hovCwos 2 v v fast v enaste v =
Enet0 =0 23 g L VCWOS T8V v tast o~ enatie w Im
Erwe 0 WO o) RVCMOS 5 8V v  tam v enaste v @

Step 25: Next, proceed to the clock configuration. Ensure that the CPU and DDR values match those shown in the

image below.
Page Navigator bl Clock Configuration
Zynq Block Design Basic Clocking  Advanced Clocking
PS-PL Configuration Input Frequency (MHz) 33.333333 CPU Clock Ratio| 6:2:1 e
Peripheral /O Pins « Q = o ot
MIO Configuration Search: ©.-
ICIocK TTguraTon I Component Clock Source Requested Frequ... Actual Frequency(... Range(MHz)
~  ProcessorMemaory Clocks
DDR Configuration cPU ARM PLL ~ | B6G6.666666 G66.666687 50.0:767.0
SMC Timing Galculation DDR DODRPLL w | 533.333333 533.333374 200.000000 : 534.000004
~ |0 Peripheral Clocks
Interrupts SMC 10 PLL 100 10.000000 10.000000 : 100.000000
QsPI 10 PLL w1200 200.000000 10.000000 : 200.000000
EMETO 10 PLL | 1000 Mbps | 125.000000
EMET1 10 PLL 1000 Mbps 10.000000
SDIO 10 PLL w1100 100.000000 10.000000 :125.000000
SPI 10 PLL 166.666666 10.000000 0.000000 : 200.000000
> CAM
~ PL Fabric Clocks
[ Erl K KN NP w I8N &0 AnanNnn N ANNANA - 250 AN00NN
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Step 26: Change the model number to "MT41J256M16 RE-125", leave other settings as default, and
click OK. This completes the core configuration of ZYNQ so far.

Page Navigator - DDR Configuration Summary Report
Zynqg Block Design Enable DDR
PS-PL Configuration -
g « Q| = | =
Peripheral IO Pins Search: -

MIO Configuration Mame Select Description

~ DDR Controller Configuration

Clock Configuration Memory Type DDR 3 ~ | Type of memaory interface. Refer to UG585 Zyng Technical Reference Ma
DDR Canfiguration Memory Part Memory component part number. For unlisted parts choose "Custom™ T
Effective DRAM Bus Width 32 Bit s Data width of DDR interface, not including ECC data width. Refer to UGS
SMC Timing Calculation ECC Disabled Enables error correction code support. ECC is supported only for an effe
Interrupts Burst Length 8 ~ | Minimum number of data beats the controller should use when commur
DDR 533333333 Memory clock frequency. The allowed freq range is (200.000000 : 534 0C
Internal Vref C] Enables internal voltage reference source. Disable to use external Vref

Step 27: Click "Run Block Automation" in Vivado. The software will automatically complete some tasks
related to exporting ports.

Diagram » Address Editor b

@ e 1 = & Q + T S = o, O Sl | = Default View

}' Designer Assistance available.IRurl Block Automation I
processing_system7_0
s -

DDR
FIXED IO -
R - USBIND O —
=] M-AxI_GPo_AcCL ZYNG, M_AXI GPO
FCLK_CLKO
FCLK_RESETO_M

- |

Step 26: Click "by default "OK”

Make Interface External: FIXED_IO, DDR
Cross Trigger In: Disable -

Cross Trigger Out: Disable s

Sance
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Step28: Connect FCLK_CLKO and M_AXI_GPO_ACLK, according to save design.

Diagram » Address Editor x

@ 6 N & O Q + & #, C o = DefaultView

processing_system7_0
i ™
DDR + ||j===[_> DDR
FIXED_IO + |||====[> FIXED_lO

- useIND_0 + |||
M_AX|_GPO_ACLK ZYNQ M_AXLGPO + [
FCLK_CLKO

FCLK_RESETO_N r

ZYNQT Processing System

Step 29: Choose "Block Design," then right-click and select "Create HDL Wrapper..." to generate a
Verilog or VHDL file for the block design, creating the HDL top-level file.

Flow Navigator = B1 OCK DESIGN - de:/ ) i
] = Open File Alt+C
”~~
~ PROJECT MANAGER -
Sources x De | Open With L4
£+ Settings
> - Create HDL Wrapper...
| 5= =
Add Sources - | View Instantiation Template
~ Design Sourc
Lan Templates -
anguage Temp G = design Generate Output Products...
<F IP Catalog IF @ de Reset Output Products...
ot Constraints
< |
~ IP INTEGRATOR [ eE e | |
Hierarchy P Sci
Create Block Design
Open Block Design Source File Proper > Remove File from Project... Deletie
Generate Block Design design_1.bd
Disable File Alt+Minus
~| Enabled
v SIMULATION < & Hierarchy Update >
Run Simulation General Proper, ' Refresh Hierarchy
IP Hierarchy >
v RTL ANALYSIS Tcl Console >
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Keep the default options and click OK.

¢ Create HDL Wrapper >

You can either add or copy the HDL wrapper file to the project. Use copy
option if yvou would like to modify this file. '

Options

Copy generated wrapper to allow user edits

@ LetWivado manage wrapper and auto-update

@

Step 30: In the block design view, right-click and choose "Generate Output Products". This step creates
essential files like IP, RTL source, and constraints for further work.

= = . — Open File Alt+C
low Navigator = & 2 BLOCK DESIGN - desig | Osaii iR 5
- PROJECT MANAGER 2 : =
Sources > Desig| Create HDL Wrapper...
Settings
= o o ~~ - +| View Instantiation Template
= =
Add:Sources e Generate Output Products...
Language Templates . s e | Reset Output Products
~ | desig
<F IP Catalog ~ @ des|
< IP INTEGRATOR
Create Block Design | Remove File from Project... Delete
Open Block Design Source File Propertie:
Generate Block Design . design_1.bd ‘ Disable File Alt+M S
’ Hierarchy Update >
~"| Enabled
< SIMULATION < & & Refresh Hierarchy
Run Simulation General Propertie:| IP Hierarchy >
|
- RTL ANALYSIS Tcl Console x Me :
» Run Linter Q = = 11 i
. . n ”
Step 31: Click on "Generate”.
- Generate Output Products e
The Tollowing output prodgducts will e generated. ‘
P e e
—n = =
~ =] design__ 1. bd (s per 1R =3
= Swnthesis
Sirmulation
IMmelermentation
s Harm Ao fF o
Synthesis (Opticoms
FoSliobal
Ut of context per 1P
P Ut of context per Block [Design
Run Settimg s
O local hhost: rNauamber of jJobs: = —
Senerate scripts onmnly
Co mot laumnch
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Step 32:In the menu bar, go to "File -> Export -> Export Hardware..." This option exports hardware
information, including PS terminal configuration details.

¢ ps_hello - [C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.xpr] - Vivado 2023.1 - X
File Edit Flow Tools Repots Window Layout View Help Ready
Project v B> oS X » == Default Layout v
|
I Add Sources.. -4 BLOCK DESIGN - design_1 2%
Sources x Design | Signals 2_00 Diagram  x Address Editor % | design_1_processing_system7_0_0.xdc  x 200
Save Block Design As... S IR
Q= [l o hello = _1/ip/d: 1] _system7_0_0/design_1_processing_system7_0_0xdc *
Close Block Design — - . o
. v design_1_processing_system7_0_0 (9 Q B B Q Read-only £
Checkpoint 4 ¢ design_1_processing_system7_0_0.dcp v
. > 70 | set_property PIO_DIRECTION "OUTPUT" [get ports "MIO[48]"] ~
I design_1_processing_system7_0_0.xdc - 4 SD s B =
® processing_system7_v5_5_aw_atcy 72 i set property iostandard "LVCMOS18" [get ports "MIO[47]"]
{ ® processing_system7_v6_5_b_atcy v | 73| set property PACKAGE PIN "BL4" [get ports "MIO[47]"]
P | T D ) >N set_property slew "slow" [get ports "MIO[47]"]
Hierarchy  IP Sources  Libraries ~ Compile Order i78eliproperty: drive 767 [get ports "MIO{A717]
Text Editor » | set_property pullup "TRUE" [get ports "MIO[47]"]
set_property PIO_DIRECTION "INPUT" [get ports "MIO[47]"]
Source File Properties 2 —SE B # B 46]
| set_property iostandard "LVCMDS18" [get_ports "MIO[46]"]
Export Export Hardware... 1 g 2
2m7_0_0.xdc - & 50 | set_property PACKAGE_PIN "D16" [get ports "MIO[46]"]
{ Print.. o Export Block Design... | 3 51 | set_property slew "slow" [get ports "MIO[46]"]
F - - = - 2 | set_property drive "8" [get ports "MIO[46]"] o
Exit < >
Export Simulation...
v RTLANALYSIS TciConsole x Messages |Log | Reports | Design Runs 2 _00
» Run Linter al=z|e|n
> Open Elaborated Design ! create_ip_run leset sources_l] C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.srcs/sources_l/bd/design_l/design_l.bd] ~
© launch_runs design_l_processing_system7_0_0_synth 1 -jobs §
[Mon May 6 15:36:09 2024] Launched design_l_processing_system7_0_0_synth 1...
v SYNTHESIS (] Run output will be captured here: C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.runs/design 1 processing system7_0_0_synth_1/runme.log

es C:/Users/Us

_simulation -of /FBGR/ps_hello/ps_hello.srcs/sources_l/bd/design 1/

ects [get_fi

» Run Synthesis

> Open Synth

v IMPLEMENTATION |
Export a hardware description file for use with the Vitis tools

L Type here to search ‘ Mostly sunny

Step 33: Click Next and Finished

P) hello - [C:/Use er/Desktop/FPGA/ps_he _helloxg Vivado 202
Eile  Edit Flow Tools Reports Wil 4 Export Hardware Platform X Ready
=, =] a8 = Default Layout v
Output
Flow Navigatos BLOCI y : , ] ? X
= Set the platform properties to inform downstream tools of the intended use of the target platform’s hardware design. ‘
v PROJECT MANAGER
Sourt i7_0_0.xdc  x 200
£+ Settings
K Sources Q e Pre-synthesis )_0/design_1_processing_system7_0_0.xdc *
This platform includes a hardware specification for downstream software tools.
Language Templates Read-only &
Include bitstream 048] "] ~
¥ IP Catalog This platform includes the complete hardware implementation and bitstream, in addition to the hardware specification for
software tools.
[471"]
1P INTEGRATOR . "1
Create Block Design Hier
Open Block Design 471"
Generate Block Design Sour
[461"1
I de| "
Vv SIMULATION
Run Simulation | Geng 5 M
Vv RTLANALYSIS Tl ¢ i | 8 i 5]
» Run Linter Q
> Open Elaborated Design c rces_l/bd/design_l/design_l.bd] ~
1
&
v SYNTHESIS R 0_synth_1/runme.log
» Run Synthesis & esign_1.bd] :/Users/User
> v
>
Vv IMPLEMENTATION =

Vi
Export a hardware description file for use with the Vitis tools

P Type here to search °C Mostly sunny

Hardware design part is completed. Now we need to launch Vitis.

#2514/U, 7th 'A" Main Road, Opp. to BBMP Swimming Pool, Hampinagar, Vijayanagar 2nd Stage.Bangalore-560104, Karnataka , 560104
Ph: 080-2340-4924  Email:info@tenettech.com



" T ErNET
- . N ECHIMNE T RROMNIC S

AT e r sy W e oy e Feee a7

Create Application project

Step 1: Vitis is an independent software tool. To open Vitis, go to "Tools -> Launch Vitis" and start the Vitis
software.

¢ ps_hello - [C:/Users/User/Desktop/FPGA/ps_hello/ps_hello.xpr] - Vivado 2023.1 il o x
Elle  Edit Flow Tools Repots Window  Layout View  Help Ready
s, [ yalidate Desion " | » == Default Layout -

Create and Package New IP. )
~ PROJECT MANAGER
Srouininiarey elnnen | ? — oo « | Address Editor x| desian_1_processing_system7_0_0.xdc 200
& setings Enable Dynamic Function eXchange o
1 system?_0_0/design_1_processing_system7_0_0xdc
Add Sources Run Tel Script | - i AT - n2h =X St
c 1oy F3Ing_system7_0_0 (9 ~ e
Language Tempi{ Property Editor L i ooas Q o] | o Read-only ¥
Assoclate ELE Flles. v e set_property PIO_DIRECTION "OUTPUT" et rtas "MIO[48]" -~
4 1P Catalog lenn_-ymm7_u_ox¢= S b [get_por r481"]
Generate Memory Configuration File. { 7S " 4
; em7_v5_5_aw_atey set_property iostandard " 18" (get_ports "MIO(47]"]
~ 1P INTEGRATOR Somplla@imuiation Libanes: Mem7_vs_s_b_atcv ~ set_property " [get_ports "MIO[47]"]
> i | set_property 471"
Create Block Des| Vivado Store f Complle Order 5 | set_property "
Custom Commands , ¢ | met property pullup "TRUE" [get ports "MIO[47]"]
©Open Block Desig | set_property PIO_DIRECTION "INPUT" [get_ports "MIO[47]"]
Generate Block D. Launch Vits IDE ? oo ox v Sosot 7 vesot. s NIOIEE 4 =
set_property iostandard " (get_ports "MIO[46]"]
©Q  Language Templates Loxac - o set_property PACKAGE_PTI (get_porta "MIO[46]"]
¥ SIMULATION & Sottings. | N 1 | set_property alew "alow" [get_porta "MIO[46]"]
set_property drive "8" [get _ports "MIO[46]"] ~
Run Simulation General | Fropertios < 5
~ RTLANALYSIS TelConsole  x Messages |Log |Reports | Design Runs ?-00
» Run Linter B B o
> Open Elaborated Deslgn ~fixed - ~file Ci/Users/u top/FPGA/pa_hello/design_l_wrepper.xaa ~
INFO: ™ (Project 1-1918] Creating Hardware Platfo Users/User/Deskuop/FRGA/ps_hello/design | wrapper.xsa ...
INFO: (Project 1-1943] The Hardware Platform can be used for Hardware
v SYNTHESIS INFO: [Project 1-1841] Succesafully created Hardware Platform: C:i/Users/User/Deaktop/FPGA/pa_hello/design_l_wrapper.xaa
> Run Synthesis () INFO: (Hsi 55-2053] elapsed time for repository (Fi/Xilinx/Vivado/2023.1/date/embeddedsw) loading 1 seconds
> Open Synthesized Design ~
< >

~ IMPLEMENTATION |
Launch Vitis IDE

O Type here to search

Step 2: Select the previously created folder and click "Launch".

&N Ve D Lawnchr =

Select » directory s workspace

Vits OF vies The mavbigid e Svetiory 1s Sire @) preferens es and Gecviageraat onf it

Wertapece s’ User Decincg 3 POA pe_ Nelic [

L Use ths an $he dofput and do not ask agen
» Revtore ather Waorhagad e
» Recest Workapeces

Step 3: Click on "Create Application Project."

roaay

o Eon  Flow  Tools  Repads  Window  Layout  Miew  Melp S
o = e, W o
BLOGK DESIGN - dasian_.1 z =
Vitis 1DE [ =
ch Vitis  Praject  Window  Heip

X

=5 Dafault Layout ~

= sewngs

Ada sourcel
Language 1
@ 1P Catalon Click Here!
To preview the new Vitis Unified IDE

~ e inrearaTon
Croate Blod

i VITIS
| E

¢

SIMULATION
Run Simury
~ RTL ANALYEIS —_— —_— — =

> rRun Linter PROJECT PLATFORM RESOURCES

> opan Eland

Add Custarmn Platform Vitis Docurnentation

~ avnTHESIS
> Run aynine)

N Create Platform Project Vitis Developer

~ IMPLEMENTAT Craate Library Project
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Step4: Click on Next.

(W] | kel 7~ & Y New Application Project

Create a New Application Project
- %

poste

This wizard will guide you through the 4 steps of creating new application projects.

1. Choose a platform or create a platform project from Vivade exported XSA
2. Put application project in a system project, associate it with a processor

3. Prepare the application runtime — domain

4. Choose a template for application to quick stort development

Platform
Project

Processor

= A platform provides hardware informatior
- A system project contains one or more appl
- A domain provides runtime for applications, such as operating system or BSP.
« A workspace can contain unlimited platforms and unlimited system projects.

ment settings.

nd
ications that run at the same time.

[C]5kip welcome page next time. (Can be reached with Back button)

@

Page: 16,01 19 |

£ Type here to search

< Back

Finish

Cancel

Step 5: Click on "Create a new platform hardware (XSA)". The software provides some hardware platforms

for boards, but for your own hardware platform, you can choose "+".

2L o
% | Platform
A=4

TU New Application Project

€ Please select a platform to create the project

Select a platform from repository |1 Create a new platform from hardware (XSA)

Hardware Specification

[=] =

-

o9

XSA File:

Platform name:

@

< Back Next 5

(e

CAA daka

Step 6: Select the previously generated XSA file in project folder and click "Open".

W Create Platform from XSA

- e << FPGA > ps_hello ~

Organize ~ New folder

I This PC = Fasie
~8 3D Objects -metadata
B Desktop ps_hello.cache
=] Documents el oo
=_hello.hw
B Powniloads zs:hello.ip_user_files
b music ps_hello.runs
=1 Pictures ps_hello.sim
Videos ps_hello.srcs
= Local Disk () RemoteSystermsTempFiles
45 CD Drive (D:) ] design_1_wrapper.xsa
— New Volume (E:)
— Local Disk (F:) ol ==

File narme: [design_1_wrapper.xsa

Search ps_hello

V\{JYUYVYE/Y

']

v

wiww

am | >
Trpe
File
File ¥
File
File
File
File
File
File
File
xSA

CTancel
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Step 7: Under "Generate boot components," check the option to have the software automatically
generate boot components for the project. This is usually selected by default. Click "Next."

(W] bl 9 - A Y New Application Project o =
File Hon a
e laitoin °
7 7" | Note: A platform project will be generated automatically in workspace for the selected XSA. It can be customized later.
Paste
2 From
Shiptoacy Select a platform from repository || Create a new platform from hardware (XSA)
Hardware Specification = =
CAUsers\U ps_ 1
vek190
XSA File: | | Browse...
Boot Components
[Z] Generate boot components
Platform name: : [ design_1_wrapper
| @ <Back [ Neas ] Fiish Cancel
pagei 190120 |L_
: Vs & 5 g, ENG  353PM
AL : B A% ys' 562000

£ Type here to search

Step 8:Fill in the project name as "hello" and provide a project description if needed. Click "Next."

(=] B3

e o T New Application Project

% | Application Project Details
Specify the application preject name and its system project properties
A4

» 9

Application project name: [ heiio |

System Project
ew system project for the application or select an existing one from the workspace

System project details

E
s
B2 System project name: | hello_system|

Associated applications
hello

P 1
pi7_cortexad SMP.

< Back il st

@
= ENG  3:57 PM
~ & = ae e =

5/6/2024

=] & T

Step 9: Keep everything as it is and click "Next.”

2 O =) =
<} -
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Step 10: In the template selection, choose "Hello World" and click "Finish."

(W] i 9 - O DY New Application Project - *

-

Templates
b j S Select a template to create your project.
2 Copyl
Paste

 Form| =

Available Templates:
N —— :

Clipboard

#

Hello World

v software template: Let's say "Hello World' in C.
Dhrystone
Empty Application (C++)
Empty Application(C)
Hello World
IwlP Echo Server
IwlP TCP Perf Client
IwlP TCP Perf Server
IwlP UDP Perf Client
IwlP UDP Perf Server
Memory Tests
OpenAMP echo-test
OpenAMP matrix multiplication Demo
OpenAMP RPC Demo
Peripheral Tests
RSA Authentication App
Zynq DRAM tests
Zynq FSBL

o]
u

@ o | isas

Page: 21 0 21 |

ENG  4:00PM

A Type here to search . i ) ] e 37°C Partlysunny A & T3 dy

USs  5/6/2024 EZ

Step 11: After completion, you will see that the projects have been generated.

&5 Explorer EE] B Sy &8 = O
> design_T1_wrapper
L EI hello_systermn [ design_1_wrapper ]
L EF hello [ standalone_ps7_cortexa® 0]

> IEﬂ.l Includes

¥ [= src

» 2L _ide

“E hello.prj
A, hello_system.sprj

Step 12: Double-click on the .spr file in design_1_wrapper.

S design_1_wwrapper
» = export
= hww
= loegs
psf_cortexaS_ O
[/ rescurces
= =wngq_~Ff=skl

n platform.spr
platform.tcl

> IEI hello_systerm [ design_1_wrapper ]

YY ¥V VY

DI
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Step13: Click to open the Board Support Package (BSP). Here, you can find the peripheral drivers included

in the project. Xilinx provides driver documentation and example imports within the BSP.

& ps_hello - design_1_wrapper/platform.spr - Vitis IDE - =] X o @
o) | File  Edit Search Vitis Project Window Help [
) i e - |- |-i-O~iF-iED T W ¥ Q. [ Design | 4¢ Debug
Paste
=A@ [ &4 hello_system K hello DU design_1_wrapper ©3 | )
up
iy :
type filter text = @
e [oper JE @ & %| goara Support Package
~ & design_1_wrapper
ol ~ £} ps7_cortexa9_0 View current BSP settings, or configure settings like STDIO peripheral selection, compiler flags, SW intrusive profiling, add/remove libraries, assign drivers to
TES o bl peripherals, change versions of OS/libraries/dfivers etc.
(¥ Board Support Package Modify BSP Settings... | Reset BSP Sources
~ [01 standalone_ps7_cortexa9_0
i)} BoaTd SUppOFE Package A BSP settings file is generated with the user options selected in the settings dialog. To use exising settings, click the below link. This operation clears any existing
modifications done. All the subsquent changes are applied on top of the loaded settings.
Load BSP settings from file
Operating System
Name: standalone
Version: 8.1
Descriptions Standalone is a simple, low-leval software layer. It provides access to basic processor features such as caches, interrupts and exceptions as well as
e the basic features of a hosted environment, such as standard input and output, profiling, abort and exit.
Documentation: -
Drivers  Libraries
| Nsme Driver Documentation Examples ~
ps7_ddre 0 generic . -
pe7_dev_ctg 0 devefg Documentatian Link Impart Examp
R, Yranl nantation Link Imp:
ps7_dma_s dmaps Link import Examp
ps7_ethernet 0 emacps Resumentation Link Impert Examples
ps7_globaltimer_0 generic 5 -
BT SaIE0, Shiens Documentation Link import Examole =
Ps7_gpv.0 generic v =
Main | Hardware Specification | ‘:
Page: 22 9| +)

£ Type here to search

tly

unny

Step 14: In the selected Application Project, right-click and choose "Build Project," or click the

"Hammer" button on the menu bar to compile the project.

4 | = AL e =N I . -
& ps_hello - hello/hello.prj - Vitis IDE — [=] <
File Edit  Search Vitis Project Window Help L]
= s~ | ®B-R~iAe-O~-iv- DT E x - Q [ Design  #& Debug a,
& [l Explorer 22 | E1[3plea 8 = O |[8z outtine = = =
m @ logs ~ || There is no active editor that provides an outiine. d
(> ps7_cortexad_0
& resources e
&> zynq_fsbl
r,l platform.spr x
| platform.tel 2
Il hello_systam [ design. i wrepper 1
~ RS- Sie s aal S
i Ine New 2
o T e yatarn Frojace oY
o< _id Paste CtrieV
& hel
% hello,, 3¢ Delete Delete
Refresh Fs
<
@iy ImportSources... [ncremental Build of Selected Projects | “+
DU Assistant 53 Export as Archive
Build Project
design_1 Clean Project
~ EF hello_sys
(o ;=":I T8 Generate Linker Script
S el C/Ce+ Build Settings
jjzsoy > bie 2l Problems [ Vitis Log (D) Guidance 4 w5l & MBSOy = 00
Run As > |sole [hello, Debug]
Debug As >
Properties Alt+Enter
« £} hello

2 o = SRV PHPEY SO PRI & S AL PO - -
U ps_hello - hello/hello.prj - Vitis IDE - © =
File Edit  Search Vitis Project Window Help
(= ~ it rO-iyr-iDgm - > QA  il#Designi| #r Dabug
= 21 [ Shlis & — G |(8 ovtine = =]
m -~ There is no active editor that provides an outline.
7_cortexad_0
urces @ Console 53 |21 Problems [H] vitis Log (D Guidance O | B &H | M B >3~ o

& 2ynq_tabl

platform.tel
n [ che

rapper
R i, .01

o N\ O
& design_1. wupperu latform]
~ B hello_systes te
&7 heite tapplication]

=l

T Release
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hello, Debug]

uild of configuration Debug for project hello ===+
rint-directory pre-build

no Tinaro pre build step

ine-print-directory main-build
Gilding File: ../are/helloworld.c:
Sgc cospilent

al

nvukinxl ARM w

{fmessage-lengen-o
Jareshetioworid:

‘Building file:
‘Invoking: ARM v7
arm-none-eabi-gec

“Finizhed building:

. ./3rc/platform.c’
Bee . compiién

“Wall -00 -g3 -c

Vererpiftrorm.

‘Building target: hello.elf’
* Invok gee 1inkee*
arm-none-eabi-goc -mepu-cortex-ad -mfpusvpy3
“Finished building target: hello.elf'

‘Invoking: ARM v7 Print Size’
abi-size hello.elf |tee
aata bes dac

"hello.elf.zd
hex filename
2740 hello.elf

cext

19104 1144 22368 42016
‘Finished building: hello.elf.size

16:15:59 Build Finished (took 949ms)

Ph: 080-2340-4924

“MT sre/helloworld.o®
~fmessage-length=o -MT"src/platform.o”

-mfloat-abishard -Wl,-build-id=none

Console See the compilation process and generate self document

“mepu=c

ortex-a0

-zpecas=Xilinx.zpec

“mepuscortex-ag -mfpusvipva

S N R

-mfloat-abishard -IC:/User

w1, -

T

w1

“mfloat-abi-hard

N L T Y

1tponeerg

-xC:/sum
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Step 15: Connect the JTAG line to the development board and the UART or USB line to the PC.
Step 16: Use PuTTY, a software that serves as a serial port terminal debugging tool.
Step 17: Click on

e =
N ps_helt

"Run As" and select "Launch Hardware (Single Application Debug)."

9

Step 19: For reliable system debugging, it's recommended to right-click on "Run As -> Run Configuration."

Inside the configuration, you will find "Reset entire system" selected by default, similar to Vitis. If your
project includes PL design, ensure to also select "Program FPGA" for complete functionality.

# 2514/U, 7th 'A" Main Road, Opp. to BBMP Swimming Pool, Hampinagar, Vijayanagar 2nd Stage.Bangalore-560104, Karnataka , 560104
Ph: 080-2340-4924  Email:info@tenettech.com



" T ErNET
. N ECHIMNE T RROMNIC S

S T e S e i e R e e e B B St Pl

Step 20: Apart from "Run As," there's also "Debug As" available. This allows you to set breakpoints and
execute single-step debugging. Click on debug and select "Launch Hardware (Single Application Debug."

e M= 2001 3200 (110 oAl 3 couoe 1o L = X
3 :
£ ps_hello - hello/hello.prj - Vitis IDE - o X
File Edit  Search Vitis Project Window Help o
= = b | B~ RO~ i/~ DFAICEC D~ Q[ Design | 45 Debug a
‘= (R Explorer 2| Sl 3§ = 8 |[5= outine 2 Sacal
i} & logs ~ || Thereis no active editor that provides an outline. ‘ L 4
& ps7_cortexad 0
& resources & Console 52 |[£ Problems [E] Vitis Log (D) Guidance B~y =0 || &
> @ ynq fsb) TCF Debug Virtual Terminal - ARM Cortex-A9 MPCore #1
£\ platform.spr = 3
2 platform.tcl
~ [ hello_system [ design_1_wrapper ]
~ {&} hello [ stand S
> New >
4 Binaries
» &) Includes Move To System Project... &
@ Debug Paste Ctrlev =
s G src
g 3R Delete Delete
& hello.prj =] Refresh Fs
€ 3 Import Sources... 8

Assistant 52 4 Exportas Archive

Build Project

design_1_wrapg Clean Project
~ 5% hello_system [5,
> {2} hello [Applic 7] Generate Linker Script

<
Debug C/C++ Build Settings
2 Release

Team >
Run As >
Debug As > % 1launch Hardware (Single Application Debug)
Properties Alt+Enter ;[} 2 Launch SW Emulator (Single Application Debug)
&, 3Launch Hardware (Single Application Debug (GDB))
“ Debug Configurations...

€} hello

<
ﬂ L Type here to search ‘

ENG
us

37°C Partlysunny A O ¥ dx

Step 21: After debugging, you can view the breakpoints you have set.

°° - = 2INA1 1200 11wk £AL = LIDCE €1 mas et = b
- L\ ps_hello - hello/src/helloworld.c - Vitis IDE - [m] X
File Edit  Search Run Vitis Project Window Help o
— | ®S~-|R~-iBix|m ENES-3RR|ZTADLSEMIFE-0 S S Q_ i[2 Design 4% Debug Q
‘& (@ Explorer m'\aAssimm = B |[& hellosystem % hello Tl design_1wrapper | [ helloworld.c 52 = e . 6LE. BAM. Ui =
1 BEe 37  * PS7 UART (Zyng) is not initialized by this application, since ~ B & s et 8 &
" * bootrom/bsp configures it to baud rate 115200 -
> design_1_wrapper A Name Type Value
[ hello_system [ design_1_wrapper] || ag  ® .. ==
~ {2} hello [ standalol 0] * | UART TVI BAUD RAT! |
> 3%, Binaries e e s s P
» ) Includes * uar 9600 ) )
ek *  uartlite Configurable only in HW design
& Debug *  ps7_uart 115206 (configured by boc /bs (<]
v & src e
[l helloworld.c
» [0 platform_configh #include <stdio.h> [
[ e #include “"platform.h”
[ platformh @ #include "xil_printf.h B ihemory SX] = o w
T Iscript.id & o = =7
[2 Xilinx.spec = int main() I S S
> % _ide | ME X U,
% hello.prj |2 init_platform();|
& _ide ) print("Hello World\n\r");
& hello_system.sprj print(“Successfully ran Hello World application”);
cleanup_platform();
return 9;
i
‘ 5
< >
© Console 52 | BJ Vitis Seri.. ) Executa.. [j) Debugs... [[] VitisLog [£] Problems G Debugg.. = [ || XSCTCons.. 53 | Gl Emulati =
~ B~ W - En
TCF Debug Virtual Terminal - ARM Cortex-A9 MPCore #1 XSCT Process
55: init_platform(): ~
xsct$ &
< >
xsct¥
« | writable | Smart Insert 55:21:2258 &

ﬂ L Type here to search ‘
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